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Introduction 

Overview 
The Varian MS Workstation Version 6 software controls the 300 Series 
Quadrupole instruments, associated Varian chromatography modules and 
several modules from other vendors. Use this manual to maximize your 
application of the features.  

Additional Manuals 

300 Series Hardware Operation Manual 
This manual, part number 3954912500, provides the necessary information for 
using, maintaining, and repairing your 300 Series System. This information is 
also available in Online Help.  

MS Workstation Software Reference Manual 
This manual, part number 391496300, explains using the MS Workstation 
Software with acquired data. These operations include displaying and reviewing 
chromatographic and mass spectral data, library searching, and quantitative 
analysis. Although these tutorials use Saturn 2000 ion trap files, they illustrate 
the principles of MS software. 

Data Acquisition with 3800 GC Control 
This manual, part number 391473100, explains how to build methods, acquire 
data, and operate the 3800 GC with your Varian MS Workstation. This manual 
also describes the configuration of the 3800 GC for standard Ethernet 
communication with the System Control application. 

Data Acquisition with LC Control 
This manual, part number 391473200, describes the operation of the MS 
Workstation with Varian HPLC modules. It covers configuring an instrument for 
data acquisition, building a method, and running samples. 
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DIP/DEP Solids Probe Manual 
This manual, part number 395414900, which comes with the optional DIP/DEP 
probe for the 300-MS or the 320-MS GC/MS, describes the operation of the 
DIP/DEP solids probe. 

Chromatography Hardware Manuals 
Refer to the manuals of your chromatography modules. 
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MS Workstation Applications 

Overview 
The applications of the Varian MS Workstation Toolbar are: Methods, Data Files, 
SampleLists, RecalcLists, SequenceLists, and Reports. They are on the Varian 
MS Workstation Toolbar and in the Varian MS Directory. When you install other 
MS Workstation options, such as Star Finder and Star Custom Report Writer you 
can add those application buttons. The followingtgr4 is a brief introduction to the 
applications. Each is explained in detail in later sections. 

 

System Control - Control Varian instruments including the 300 Series 
MS, HPLC, and GC modules. There are two main windows, the Configuration 
window, and the Data Acquisition and Control window.  

Method Builder - Edit or create methods for the 300 Series MS, Varian 
HPLC, and GC chromatography modules.  

 Automation File Editor - Build SampleLists, RecalcLists, and 
SequenceLists for System Control automation. You may also build these 
Automation Files directly in System Control. 

 MS Data Review - Review chromatograms and spectra, do library 
searches, and review and process quantitation results. 

 Standard MS Report - Edit the standard MS report template.  

Custom MS Report - Create custom report templates. 
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  Security Administration - Select MS Workstation security options and 
passwords. 

Data File Conversion - Convert older data files collected with Varian Ion 
Trap Mass Spectrometers to the current data file formats. Keep an archive of 
existing data with current data files for quick and easy reference. 

  DAT to MS Conversion - Convert Kodiak DAT files to MS Workstation 
XMS format. 

 Batch Reporting - Automatically print one or many reports by dragging 
data file names from the Explorer or My Computer window and dropping them 
onto the Batch Reports window. The reports are printed with the method last 
used to process the data files. 

View/Edit Chromatograms - View and edit chromatographic data 
gathered by conventional HPLC and GC detectors. You may load up to 7 
chromatograms, manually or automatically assign or re-assign chromatogram 
events, and generate new results. 

Standard Chrom Reports - Display and edit the preferences for reports 
generated from traditional chromatography detectors such as UV/Vis or FID 
detectors. These reports may be viewed one-at-a-time. 

  Compound Set Editor - Create and edit sets of compounds in the MS 
Data Handling Method allowing activation or deactivation under automation. 

Quick Start - Make a single LC/MS or GC/MS injection quickly. Do not 
use this for multiple injections. Refer to the Injecting Samples and Automation 
section for more information. 

PolyView™ 2000 - View and process PDA data from your Varian HPLC 
Photo Diode Array detector. 

Aurora PDA - View HPLC Photo Diode Array data in a 3D presentation.  
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MS Workstation Toolbar Options 

Moving the Workstation Toolbar 
You can move the Workstation Toolbar to any edge of the Windows screen. Click 
in an area of the Workstation Toolbar that does not contain Application or 
QuickLink buttons and drag the toolbar to the edge of the screen that you desire. 
The next time you open Workstation the toolbar will be at that spot.  

The Workstation Toolbar Options Menu 
Put cursor over an area of the Workstation Toolbar without an application or 
QuickLink button, and right-click to display a menu. 

 

Move to Windows Taskbar 

Display the Workstation Toolbar as a Windows Taskbar icon.  

Select Move to Windows Taskbar from the Workstation Toolbar options menu. 
Taskbar icons appear in the lower right of the Windows Taskbar. Click the 
Workstation Toolbar icon to display the options menu. 

Show/Hide Applications on Toolbar 

Select which MS Workstation applications to represent with icons on the 
Workstation Toolbar. The top list box shows applications displayed in the toolbar. 
The bottom list shows all installed applications not displayed. To remove an icon 
from the toolbar, select it from the top list and click Remove. To add an icon to 
the toolbar, select it from the bottom list and click Add. 

Enable/Disable Instrument Modules 

Select which MS Workstation instrument modules are available. Available 
instrument modules are in System Control, if they are connected and turned on.  
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The list on the left has all the instrument modules currently installed and enabled 
in the MS Workstation. The list on the right shows all instrument modules that are 
installed but not enabled. To disable an instrument module, select it from the list 
on the left and click Disable. To enable an instrument module, select it from the 
list on the right and click Enable. 

Small Toolbar Buttons 

 

When Small Toolbar Buttons is enabled, a smaller version of the Toolbar opens. 
Notice that the graphics for some icons are slightly different. 

Application Descriptions  

Pause the cursor over an icon or a button to display a description. 

Run Application 

List the applications in the Workstation Toolbar. Click to open the application. 

Pick Data File for QuickLink  

Lists the eight most recently used Data Files in order of use. When you select a 
data file, it is displayed in the QuickLink button. 

Pick Method for QuickLink  

Lists the eight most recently used Methods in order of use. When you select one, 
the Method displayed in the QuickLink button changes to the selected file. 
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Help On 

Displays all applications on the Workstation Toolbar.  

Product Support Web Site 

If you have Internet access and a web browser installed on your computer, click 
to open the Varian MS Workstation Product Support Web Site. It has the latest 
software and documentation updates for the MS Workstation suite of products, 
and notes, tips, and answers to frequently asked questions. Visit this site 
periodically for new information. 

About Workstation Toolbar 

Displays the About box for the Workstation Toolbar, which contains information 
about the MS Workstation software version, installation history, and a list of the 
instrument control modules installed.  The following is an example. 

 

Validate Installed Files - Uses checksums to test and document errors.  Print a 
report that documents the file system tested, the success or failure of the test, 
the date printed and tested, the ID of the person logged in (if login IDs are used). 
You can include a signature line. For more details, refer to online help. 
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Quit 

Click to close the Workstation Toolbar application. If you choose to run the 
Workstation Toolbar automatically when Windows starts, the Workstation Toolbar 
reappears the next time you start Windows. 

Launching Applications from the Workstation Toolbar 

Application Icons  

 

MS Workstation applications are icons on the Workstation Toolbar. As you move 
the cursor over them, the name of the application appears below the cursor. 

Click an icon to launch that application. 

Data File and Method QuickLink Buttons 

 

The QuickLink buttons are on the right of the application icons. They correspond 
to most recently used Data Files and Methods.  

Most Recently Used Data File - Display options for the Most Recently Used 
Data File or select a different data file from the list of most recently used files. 
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Most Recently Used Method - Display operations that can be performed on the 
Most Recently Used Method or select a different method file from the list of most 
recently used method. 
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System Control 

Overview 
This section presents an overview of System Control functions. Other functions 
are explained in detail in later sections. 

Double-click anywhere on the Configuration screen to view the Instrument Status 
and Control window. 
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Instrument Window 
Use the instrument window to monitor status, data acquisition, the status of 
modules assigned to the instrument, inject one or more samples, and do batch 
recalculations. Starting at the top of the window, these features are System 
Control Menu, System Control Toolbar, Quad Status window, and various 
displays.  

 

 

Quad View Readback View 

MS Chromatogram View MS Spectrum View 
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System Control File Menu 

 

Activate Method - Select an existing method. This sets the conditions for the 
connected modules such as, LC, GC, MS, AutoSampler, and data handling.  

Upload Active Method from Modules - Save conditions from the existing 
modules in a new or existing method. This method becomes the active method.  

New SampleList - Create a SampleList.  

Open SampleList - Open an existing SampleList. 

 

New RecalcList - Create a recalculation list. 

Open RecalcList - Select an existing recalculation list.  

NOTE: Process a RecalcList in System Control (click Begin) or in MS Data 
Review. In MS Data Review, select Quantitation> Process/Review RecalcList. 
Although Processing a RecalcList takes longer from System Control, you can use 
AutoLink functions including automated reporting with templates such as 
EnviroPro, ToxProPlus, and Multicompound Reports. 

New SequenceList - Create a sequence list.   

Open SequenceList - Select an existing sequence list.  
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Print and Printer Setup are described in the MS Workstation Software 
Reference Manual. 

Edit Menu 

Edit Module Info 

Click Edit and select Edit Module Info 

 

 

Documenting Module Information - Each module in your system (300 Series, 
3800 GC, LC modules, Combi PAL, or HTS PAL AutoSampler) has a message 
log and screen. Use Module Information to keep a record of module 
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performance, maintenance, hours used, or other comments. From the System 
Control menu bar, select Edit > Edit Module Info. 

Inject Single Sample Menu 
Click Inject Single Sample to open the Inject Single Sample window. Enter 
information about your sample. The 300 Series Module and all modules in the 
system must be in the Ready state before you make an injection. You can do a 
manual injection or use the autosampler. 

 

 
 

Select a Sample Type from the list: 

 

 
Click Injection Notes to enter a description or comment. 

 

 
Use AutoLink to enter a command to execute a program after the data file is 
acquired. For example, you can create and print sample reports. To run a 
Custom MS Report in automation, enter the directory path and the name of the 
Custom MS Report template (for example C:\VarianWS\EPA525.swt) in the 
Command line. Note that Custom MS Reports templates are stored in the 
VarianWS directory. Use the browse command to select the command 
executable files.  
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Make a selection and click OK. 

Automation Menu 

 
 

Begin SampleList - Automation begins at line 1 and ends at the last line. 
Open SampleLists from the File menu. 

Begin Sequence - Begin an open SequenceList. You can change methods and 
SampleLists during an automated run. Open the Sequence from the File menu. 

Begin At - Start automation at a particular sequence or SampleList line and run 
until the last line is completed. A SampleList or SequenceList must be open to 
use this feature. 

Suspend Automation - Stop automation after the last completed sample. 

Resume Automation - Start automation after it was suspended. Automation 
starts from where it was suspended. 

Stop Automation - Stop automation immediately and reset all modules. 

Reset Modules - Bring the various modules to their ready states. 

Enable Automated Printing - Allow printer functions to work during automation. 

Recalculate Menu 

 

Begin RecalcList - Start an automated Recalculation. A Recalculation list must 
be opened under the File menu.  

Begin at Selected RecalcList Line - Process a Recalculation list starting with a 
selected line and proceeding with the rest of the list. 
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View Calibration Curves - View curves for the calibrated compounds in the 
active method. The Calibration Curve is saved as part of the Method.  

 

Instrument Menu 

 

 
Varian LC/MS #1 - Configured instrument. 

Configuration - Add new modules to the existing instrument, such as, a 
Combi PAL AutoSampler or LC pumps. 

Remove Module Names -  Remove associations between Module Names and 
Module Addresses. You can connect a Module with a different Module Name at 
that address. The next time the associated Module connects at that address, you 
are prompted to select the correct name for the Module. 

Instrument 1 Faults - Determine if there are faults in any module of Instrument 
1. See the following example. Click Update to check for new faults.  
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Setup Ethernet Communication - Set up communication between the 3800 GC 
or other Ethernet modules and System Control. Refer to the Ethernet 
Communication Setup section in one of the following manuals for more 
information: Data Acquisition with 3800 GC Control (part number 391473100) or 
Data Acquisition with LC Control (part number 91473200). 

Setup COMM Ports - Set up communication between System Control and 
modules communicating with the Workstation through the Serial ports on the PC. 
The first time you start System Control, the Star Communication Configuration 
Wizard starts automatically. Refer to Data Acquisition with LC Control (part 
number 0391473200) for more information. 

Windows Menu 

 

Show Module Windows - Display the configured module windows. In this 
example, the modules are the 212 Pumps, the ProStar 430 Autosampler, and the 
Quad. 

Iconize Module Windows - Create icons of individual module windows at the 
bottom of the screen. 

Show Automation Windows - View the open automation screens. The 
possibilities are SampleList, RecalcList, and SequenceList. 

Iconize Automation Windows - Create an icon of any open automation screen 
windows to access windows behind the automation windows. 

Arrange Icons - Arrange existing icons in a row at the bottom of the System 
Control window. 
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SequenceList - Display the active SequenceList. 

SampleList - Display the active SampleList. 

RecalcList - Display the active RecalcList. 

Instrument 1 Status - View the status of the modules connected to the system. 

Message Log - Tracks errors that occur during automation. Double-click the 
Status bar at the bottom of the Instrument window to view the message Log for 
all modules configured in the Instrument.  

 

The last section of the Windows menu displays the attached modules and their 
status 

212.24 - Stopped 

430.33 - Ready 

Quad.42 - Not Ready 

Help Menu 

 
 

Select Help Topics to display the following. Click an item in Contents to see the 
online help. 
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Click the Index tab and enter the first few letters of a word. Click the desired 
selection and click Display.  

 
 

Enter a key word or phrase to list help topics.  

 

About System Control provides information on the MS Workstation software 
version, a list of the Installed Modules, and the Workstation Installation History.   
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Validate Installed Files tests the installed system files and documents errors 
using checksums produced at the factory. These reports can be printed. 

System Control Toolbar 
The system control toolbar is near the top of the screen.  

 
 

  Create a new automation file. 

  First - open an existing automation file. 

  Second - open the Message Log file. 

  View, edit, print, or reactivate a method. 

  Open a method. 

  Edit notes for an automation file. 

  Edit module information for any online module. 

 
  Display the Instrument Status window when it is hidden. From the 

Instrument Status Window, you can access module windows if they are hidden. 

  Inject a single sample. 

  Start an active RecalcList. 

  Start an active SampleList.  

  Start an active SequenceList. 

  Suspend Automation. 

  Begin acquisition. 

  Stop an automation run. 

27  



 

 Quad Status and Control Window 
Check the status of the instrument components, monitor data acquisition, and 
process data using the Quad Status and Control window. Create your preferred 
window configuration. 

 
 

Quadrupole Module Menu 
File - Open or print a file. 

Method - Edit the current, active Method using Method Builder. 

Configuration - Synchronization signal settings and MS Options settings. 
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Sync Signal - Enable or disable the Start and Ready signals for external 
devices. To enable a Sync Signal operation, connect a cable from the device to 
the contact closure on the master instrument. 

 Click Enabled to activate the desired function.  

 Click Wiring to view a wiring diagram. 

MS Options - Hardware diagnostic tool. View and edit MS Options, and the 
current software settings.  

 Check marks indicate a Hardware match  

 X indicates a Hardware conflict If an X is present, call your 
Varian representative. 
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Tools - Access several MS Tools such as MS/MS Breakdown, Pml Editor, Plot 
tic, readbacks, in Bakeout system, and Overnight Standby. 

 

Quit Macros:  Stop any MS function in progress. 

User pml:  Enter up to 10 PMLs (macros written in “Paw Macro Language”). 

 

Run a pml by clicking the corresponding smiley face in the toolbar. 

 

Plot tic, readbacks -  Plot a graph of the TIC, up to 2 masses, up to 2 
readbacks, or a PML to monitor instrument status. Check In use and the check 
box next to the desired parameter and then click Apply. 
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Analog output - For service use only. 

MSMS Breakdown - Optimize the collision energy for any given parent mass.  
Used primarily in LC/MS.   

Bakeout System 

 GC/MS - Heats the source to 200 °C and the manifold at 50 °C for 3 
hours, then cools the system to initial conditions. Also plots a graph of 
the source and manifold temperatures.  

 LC/MS - Heats the API manifold to 65 °C and the MS manifold to 52 °C 
for 3 hours, and then cools the system to initial conditions. Also plots a 
graph of the source and manifold temperatures. 

Overnight Standby -  Turns off all gases and sets the MS to a low scan mass. 

 

Troubleshooting - Run various troubleshooting procedures.  See the hardware 
manual for more information. 

Inst setup/others - Perform initial instrument setup operations. 

 Coarse tune:  Service use only 

 Calibrate pressures: Calibrates the MS EFC/EPC pressures. 

Evacuate calgas bulb - Flush calgas into the source for several minutes.  Do 
this procedure if the calgas bulb was removed and re-installed. 

Cool down and vent - Cools the source to 100 °C; then turns off the foreline 
pump(s) and activates a solenoid allowing air to enter the source. 
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Reports - Select a print view setup. 

Help - Online Help and the About window.  

 

 

 

Reports - Select a print view setup. 

Help - Online Help and the About window.  

Quadrupole Toolbar 

 

 

 

 Choose File to Display - Open and delete data files, and edit headers. 

 Start Collecting Data - Acquire data from only the 300 Series and not other 
configured modules. Collect the current scan, which may not be the active 
method. 

 

 Print - Print the window screen.  

 Turn Detector On and Off - Control the filament or discharge voltage, 
accelerator and electron multiplier. The color of the icon indicates the following: 

 Gray - Off 

 Green - On 

 Red - A filament is broken 

 Yellow - System is in process of turning on or is waiting, for example, a 
filament delay time. If it turns yellow and then turns gray again, a fail-safe 
has prevented the filament and the multiplier from turning on. 

 Set Instrument Parameters - Set ion source and analyzer parameters, and 
trip points to protect the electronics and vacuum shut off. Tabbed views reflect 
either the GC or LC configuration. 
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EI/CI Source - (GC only) Turn on and off; calibration and CI gases and the 
filament. Set filament current, discharge voltage, and electron energy and set the 
Source and Transfer Line temperature. 

 

 
API Source - (LC Only). Select API on-off sequence, N2 filling time, and Gas 
pressure readbacks.  Select Nebulizing gas type, and set the API Housing, 
Drying, and Vaporizer gas temperatures. For normal operation mode, the API on-
off sequence is set to Automatic. 
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Analyzer - Vent the system and set the manifold temperature. Turn the CID gas 
on and off, set the electron multiplier (detector) voltage, and turn the Extended 
Dynamic Range on or off. 

 

Safety - has three sections. Only Varian Representatives can make changes.  

 High voltage enable and Ion Gauge modes 

 Trip points of the source pressure, manifold pressure and turbo speed 

 Status of the PCB Protect Switch 
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Syringe Pump- Only available for the 320-MS LC/MS or LC/GC/MS instruments. 

Refer to the Hardware manual for more information. 

 

 

 Define Scan Method - Set currently active scan parameters for Q1 and Q3, 
acquisition of centroid or profile data, and detection of positive or negative ions. 
Refer to Acquisition Method Window for more information. 

 

 AutoTune - Automatically tunes lenses, Q1 and Q3, and calibrates the mass 
scale. For information on the AutoTune process, refer to Autotune Functions and 
Options.  
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300 Series Module Views 

 

 

The five default views are: 

View I - Displays Quad Instrument status, Profile, Centroid, and Readbacks 
windows.  

View II - Displays Quad Instrument status, Chromatogram, Spectra, and Centroid 
windows.  

View III - Displays Quad Instrument status, Chromatogram, Spectra, and Profile 
windows.  

View IV - Displays Quad Instrument status, Chromatogram, Spectra, and Library 
windows.  

View V - Displays Quad Instrument status, Chromatogram, List, and Picture 
windows. 

 Select Views - Edit the five preset views. Select and display Views in the 
Quad window, shuffle them between different arrangements, and save them as I, 
II, III, IV, and V. Reset the settings with the Default button.  
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Profile - Real time plot of the digital signal acquired over the mass ranges 
scanned (profile data). 

Spectra - Post acquisition display of either profile or centroid spectra from the 
chromatograms. 

List - Program for temporary storage of lists of numbers for manipulation or 
statistical analysis by Paw macro commands. 

Centroid - Real time bar graph display of the mass peaks (centroid) of the digital 
signal acquired over the mass ranges scanned. 

Chromatogram - Real time or post acquisition display of chromatograms. 

Picture - Display program for graphing and drawing using Paw macro 
commands. 

Instrument Status - Graphic of the analyzer, showing temperature and pressure 
status. 

Readbacks - Real time text display of either analog or digital instrument 
parameters. 

Probe - Real time text and plot display of either the DIP or DEP probe. This is an 
option for either 320-MS or 300-MS systems. 
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300 Series Autotune Functions and 
Options 

NOTE: For a detailed description of Autotune steps, refer to the LC/MS and 
GC/MS sections in the 300 Series Hardware Operation Manual. 

Overview 
Autotune optimizes the instrument for sensitivity, resolution, and mass 
calibration.  

For LC/MS, a reference compound such as polypropylene glycol (PPG) is used 
as a tuning solution. You may also use a custom tuning solution. 

For GC/MS, FC-43 is used as a tuning solution. A supply bulb is inside the front 
panel. 

Both quadrupoles can be tuned in both polarities (positive and negative). A report 
with a display of the peak shapes and intensities and a text report with tuning 
details is displayed and saved to c:\varianws\methods directory. See the 
following. 
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Tune Stability - For optimum tune stability, the mass analyzer must be stabilized 
and at the set point temperature of the manifold before you start AutoTune. This 
may take several hours if the instrument has not been under vacuum for a long 
time.  

The tuning compound signal must be stable before starting the Autotune 
procedure (Cal Gas on for at least 10 minutes, and signal from PPG infusion 
stable).  

NOTE: It is not necessary to tune the instrument daily. Tune if the ion source 
becomes contaminated and there is a significant loss of signal. If this happens, 
clean the ion source and AutoTune. 

Tuning is not required after changing or replacing an ion volume; however, tuning 
the instrument after cleaning the ion source is recommended. This optimizes the 
instrument and ensures that the instrument is operating properly. 

AutoTune Options 

Click AutoTune  on the Quad toolbar. Select the Analyzer and Polarity to 
tune and/or calibrate. 

 

Tune and Calibrate - Complete optimization of the mass analyzer for sensitivity, 
resolution, and mass calibration. Set the mass resolution with a peak width of 
0.7 amu at half peak height.  

A report is generated with a graphic of the peak shapes and intensities (saved 
with mode name and date) and a text report with detailed mass accuracy and 
mass abundance. 

Calibrate - Update the loaded tune file by re-tuning mass resolution and re-
calibrating the mass. No changes are made to settings in the ion source or the 
non-analyzing quadrupoles. A new file name and report are created and saved. 
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Report - Create and save a tune report. Verify tune stability by comparing with 
previous reports to determine if re-tuning is required. Creating a report does not 
change the tune file. 

Tune to Target Ratios - Modify existing tune files. See ‘Tune to Target Ion 
Ratios’ Section. 

Calibrate Detector (EDR) - Optimize and calibrate the detector voltages for 
optimal operation over the entire dynamic range. Run this routine periodically and 
after replacing the detector. 

The detector calibration routine has two components. The first determines the 
optimal detector voltage for the maximum gain (EDR Maximum). The second 
calibrates the detector gain as a function of voltage for a series of gain 
increments. This is used to run the detector in the automatic detector adjustment 
mode, or Extended Dynamic Range (EDR). EDR automatically adjusts the 
detector voltage to accommodate either small or large ion signals over the entire 
dynamic range of the mass spectrometer.  

The plot shows detector gain as a function of detector voltage. 

 

Stop Tuning - Abort the Tuning procedures and restores the most recent Tune 
file. 

Analyzer - Tune each quad individually or tune both in one procedure. Use the 
default (Both) setting for triple quadrupole instruments. If you are using a triple 
quadrupole as a single quadrupole, you can select the quadrupole in use. 

Polarity - Set AutoTune polarity mode. 

GC/MS 
 CI - AutoTune either positive or negative 
 EI - AutoTune positive only 

LC/MS 
 ESI - AutoTune either positive or negative 
 (for APCI use ESI tune file) 

Ion(s) - Select either a specific ion or all defined ions in the Compound list. If you 
choose Single from the list, select an ion from a list of ions in the Standard 
compound. Using a single ion adds a new data point to the loaded tune file and 
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does not change existing points. If the same mass is already present, it is tuned 
and changed accordingly. A report for this single mass is created and the tune 
file is named and saved. 

Edit Standard Compound(s) - Open Compound Editor. You can modify a 
Standard compound or create a list of new compounds. 

Standard Compound(s) - List the Standard compounds available. 

Cancel - Close the Autotune window without executing a function. 

Tune File Naming Conventions - Autotune automatically names and saves 
each newly created tune file using the following format. 

Compound Name/Mode (Date created).dac 

If a file by that name already exists the file name increments. 

Example: Second Negative CI Tuning on October 6th 2003 

First file: FC-43 Neg CI (06 Oct 2003).dac 
Second file: FC-43 Neg CI (06 Oct 2003) (2).dac 

Tune to Target Ratios 
This is a GC/MS feature for EI ionization. Tune to Target Ratios modifies an 
existing mass spectrometer tune file so that relative ion ratios match user-defined 
target criteria. Examples are the ion ratio requirements for running EPA methods 
524 (BFB) or 8270 (DFTPP) for GC/MS with an EI source.  

The routine adjusts the ratios relative to the base peak of 3 to 5 calibration gas 
ions that are relatively far apart in the mass spectrum. These ions are selected 
for their proximity to ions of importance in the sample spectrum.  Ordinarily, this 
brings the entire spectrum within target ion ratio requirements.  Since it is not 
possible to make an ion peak larger, the ratio adjustments are made by reducing 
the sizes of ion peaks. This reduces some of the sensitivity.  Therefore, the user 
must verify that the ion ratios in the compound of interest (usually BFB or 
DFTPP) are not within acceptable parameters with the existing autotune file 
before running this program. 

Click either Tune the Calibration Gas Ratios directly, or Use a previously 
acquired data file.   

To tune the calibration gas ratios directly: 

1. Open the AutoTune window. 

2. Click Tune to target ratios. 
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3. In the Tune to target ratios window, click Tune Calibration Gas Ratios 
directly. 

 

4. Select the Tune Compound data file.  Ion ratios that normally pass DFTPP 
and BFB EPA requirements can be selected from the drop down list.  If other 
ion ratios are required, click Edit in the Tune to target ratios directly window. 

5. If editing the ion ratio list, input the ion mass in the left column and the target 
ratio relative to the base peak in the right column.  There must always be a 
base peak in the list with 100% as the % Area. Click Save. 
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6. In the Tune to target ratios directly window, click Proceed with tune 
button. 

7. If the ion ratios selected require peak reductions over 50%, a warning 
window appears before the program begins tuning.  Do not reduce the ion 
peaks this drastically because much sensitivity is lost. If the peak reductions 
are less than 50%, click OK. 

 

After the tune completes, save the new tune file. The system will not 
automatically implement the new tune. To implement the new tune open the tune 
file using the Restore tune tables in the Instrument Status window. 
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Standard Compound Editor 

GC/MS EI Example 
1. Click Edit Standard Compound(s) in the AutoTune widow and the following 

opens. 

2. Click New to define a new standard compound. 

 

 

3. Enter a name for the new standard compound. 

4. Enable the Clear all fields box to clear entries in the Standard Compound 
dialog box. 

5. Click OK. 
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6. In the Standard Compounds dialog box, enter information about your 
Standard Compound. 

 

Standard Compound - List Standard Compounds for the selected mode. 

Default for this Mode - Set displayed Standard Compound as the default for the 
selected mode. 

New - Add new list of Standard Compounds. 

Remove - Remove a Standard Compound. 

Comments - Enter information about the Standard Compound. 

Ion Source - Select the ion source (EI, CI, ESI, or APCI). 

Use in Tune - Select which ions are used for Tune or Calibrate. The selected 
ions are optimized. 

Use in Report - Select ions for the tune report. Only the selected ions are 
reported. 

Exact m/z - Enter the exact m/z of each ion in the Standard compound. 

No. of Isotopes - Enter the number of isotopes for the ion displayed in the tune 
report graphic. 
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LC/MS ESI Example 
1. In the AutoTune window, select ppg from the Standard Compound(s) list. 

2. Click Edit Standard Compound(s)  

 

Set Capillary (LC/MS mode only) - For standard compounds that you create, if 
the box is checked, set the capillary voltage for each ion to the value in Capillary 
(volts) field. If not checked or blank, the voltage from the capillary tune table is 
used. 

Capillary (Volts) (LC/MS mode only) - If the Set Capillary box is checked, you 
can set the capillary voltage to be used for each tune ion, otherwise this option is 
not available. 

If you are tuning with PPG, select Set Capillary and use the default capillary 
voltage values. 

 



 

48  



 

300 Series Method Builder 

Quad Method Builder 
Click Method Builder in the MS WorkStation Toolbar. 

Method Builder  
 

Edit an Existing Method 
Sometimes it is easier to modify an existing method than building a new method. 

1. Select Open an Existing Method File and click OK. 
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2. Select the method by doing one of the following: 

 Select the folder and then the file name. 

 

 Click Recent Files to display them and select one. 
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Build a New Method with the Configured Instrument 
1. Select Create a New Method File and click OK to open the Method Builder 

Wizard. 

2. Select Instrument 1. The configured instrument is added to the method.  

3. Click Next. 

 
 

4. Select a detector. After the data is acquired you can add data processing 
information to the method. 

5. Click Next. 

 

6. Create sections for post-run processing. Add MS Data Handling to enter 
integration, peak names, and other parameters. Add Standard MS Reports to 
use the standard reports. 

7. Click Next. 

51  



 

 

8. Review the information on the Confirm configuration screen. 

9. Click Next. 

10. Review the configuration  

 Click Back to make changes 

 Click Finish to confirm. 

 

11. The new method is displayed with a navigation tree on the left side and the 
method workspace on the right. Click a tree entry to open that method 
section.  
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Build a New Method adding a Varian Instrument 
You can build a method as follows: 

1. Select Create a New Method File and click OK. 

 

2. Select Custom and click Next. 
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3. Select an available module from the list and click Add to make it one of the 
Configured Modules. Other options are Add, Add All, or Remove. 

4. Click Next. 

 

5. Continue with step 3 of “Build a New Method.” 
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300 Series Acquisition Method  
Click Acquisition Method in the Method Builder tree. 

Set scan segments and define MRM experiments. The Mass List has a toolbar 
that makes completing the table as easy as using a spreadsheet.  

 

Method Specifications  
The following explains the Method Specifications in the Acquisition Method. 

Model 

Select your instrument Model. 

 

Ionization 

Select the ionization mode (EI, CI, ESI, APCI) - Electron Ionization, Chemical 
Ionization, Electrospray Ionization, or Atmospheric Pressure Chemical Ionization. 
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Method Run Time 

You have two choices: 

 Select Use run time. 

 Enter a time in minutes. If you do not enter a run time, the data will be 
acquired until the end time is reached in all other modules. 

 

Data Type  

Set the scan type (Centroid, Profile).   

Note: Quantitation can be done in ether Profile or Centroid mode. 

 

  

Collect Delay 

This feature is useful for applications with an initial clean up step.  

To delay data collection after the run starts, do the following: 

1. Check Use delay. 

2. Enter a time in minutes. The delay time begins when the run starts. 

 

Display File in Chro 

Enable to display data files in Chro. 
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Detector 

 Use EDR - (Extended dynamic range) the detector automatically adjusts 
the detector voltage over the dynamic range. EDR is calibrated during 
the Autotune procedure (see the ‘Autotune Functions’ section).  

 EDR Maximum - Use the optimum fixed voltage for maximum gain from 
the last EDR calibration (useful for low-intensity MS/MS experiments). 

 Fixed Voltage - Enter a fixed voltage for the entire method or different 
ones for each segment using Advanced Options.  

 You can have the detector turn off when the method ends. 

 

Scan Width 

Set the maximum peak scan window for an ion in single ion monitoring. The 
default value is 0.70. Increase this value if resolution on the scanning quad is 
opened (see parameter peak width). Adjust it according to the resolution. For 
example, if the resolution is 3.0 on scanning quadrupole SIM width, set the SIM 
Width between 0.7 and 3.0 for largest signal). 

 

Time Segment 
Use the arrows to select time segments. Use Add seg and Remove seg to add 
and remove time segments from the scan method. Start at Retention Time 
defines the retention time start for each segment.  

 

Scan Time 

Set the scan speed of the MS. The scan speed is the amount of time the 
analyzing quadrupole goes through the scan. For full scan or MS/MS scan 
experiments set the scan time to 0.5 seconds. The shorter the Scan Time the 
more data points can be acquired. Increasing the scan time increases signal to 
noise since the quadrupole spends more time on the particular ion. For SIM, 
SRM, and MRM, decreasing the scan time allows more transitions to be scanned 
across a chromatographic peak. When there are multiple full scan ranges in a 
single method segment, they must all scan at the same rate; despite the 
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requested dwell time. The software gives each mass range a dwell time 
according to the overall Scan Time and the relative sizes of each full scan range. 

 

 

Collision Cell Gas 

Select to enable the CID gas (such as Argon) for MS/MS operations.  

 

Peak Width 

Set the peak width for Quadrupole 1 (Q1) or Quadrupole 3 (Q3). 

Calibrated, the value from the most recent AutoTune file is the default setting and 
is appropriate for most applications (Scan, SIM).  

For SRM and MRM reactions in MS/MS mode, the peak width of Q1 can be 
increased while keeping Q3 calibrated or smaller. The signal increases by 
allowing Q1 to transmit a wider peak width while Q3 detects the product spectra 
in a narrower peak. 

 

Mass List 

Enter the desired mass range (Full Scan), single masses (SIM), and precursor 
and product masses (MS/MS). 

Q3 is used for triple quadrupole instruments only. 

 

Ion Polarity 

Click the Ion Polarity entry to switch between positive or negative ion detection. 

GC/MS 
   EI positive 
   CI positive and negative 
LC/MS   
   ESI positive and negative 
   APCI positive and negative 
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Capillary  

Only for LC/MS instruments. Enter the absolute value of the Capillary volts for 
each ion in the scan method. Method Builder enters the correct sign. 

 

 

Collision Energy  

For triple quadrupole instruments only. 

The Collision Energy is experimentally determined for each reaction and entered 
into the Mass List. It defines collision energies in electron volts for specific 
MS/MS reactions used in the collision cell. (Refer to the 300 Series Hardware 
Operation Manual, MS, and MS/MS). 

 

Requested Dwell Time 

Specify the Requested dwell time of each scan channel. The shorter the dwell 
time allows more channels to be used. Specify either the scan time or the dwell 
time.  

 

Mass List Toolbar 

Enter values in the Mass List in a similar manner as a spreadsheet. You can 
Add, Insert, Delete or Clear all lines; Cut, Copy Paste from a cell or a line. You 
can also fill down a column, or fill down or increment the values in a column (FD 
and I). You can copy and paste from or to an Excel spreadsheet. 

 

Advanced Options 
Use Advanced Options to tailor your method. The Advanced Options of the 320-
MS LC/GC/MS are displayed. These vary by ionization mode, instrument, and 
the optional ion sources (APCI and DIP/DEP probe).  

The advanced options depend on the ionization mode. 

EI - EI Overrides, User Analogs In/Out, PMLs, Probe 
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CI - CI Overrides, CI Gas Type, User Analogs In/Out, PMLs, Probe 

ESI - ESI Overrides, Valve, and Syringe Pump, Drying Gas, User Analogs In/Out, 
PMLs 

APCI - APCI Overrides, Valve, and Syringe Pump, Drying Gas, Vaporizer Gas, 
User Analogs In/Out, PMLs 

EI Overrides 

Enter values to override those specified in the method for specific time segments. 
In the bottom section, select the units for the pressure displayed. 

 

CI Overrides 

Enter values to override those specified in the method for specific time segments.  

 

 

ESI Overrides 

Enter values to override those specified in the method for specific time segments. 
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APCI Overrides 

Enter values to override those specified in the method for specific time segments. 
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User Analog In/Outs 

Use the Analog outputs to send the TIC signal to another device such as a LIMS 
system. 

Use the User Input Traces to acquire data from another detector such as an  
Evaporative Light Scattering Detector. 

 

PMLs (Paw Macro Language) 

Varian provides PML macros you can run either before or after a time segment. 
You can modify and create PMLs through Tools in the Quad Module View. 

 

CI Gas Type 

Select the Gas Type. You can also specify another gas that is configured with 
your instrument. 
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ESI and APCI Drying Gas 

Use the SelectTemp™ feature to ensure the optimum drying gas temperature for 
the mobile phase composition for ESI or APCI runs. 

 

ESI and APCI: Valve and Syringe Pump 

For the 320-MS, Use the six-port valve or the syringe pump or both. The six-port 
valve can be used in Manual, Diverter or Injector mode. Set the flow rate for the 
syringe pump.  

 

APCI Vaporizer Gas 

Enter a vaporizer gas temperature program to ensure the optimum vaporizer 
temperature for APCI runs. 
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DIP/DEP Probe (Optional Ion Source) 

Enter a vaporizer gas temperature program to ensure the optimum vaporizer 
temperature for DEP runs. 

 

Setting up MS and MS/MS Acquisitions 

Overview 

MS Operations 

 Line 1 - Single Ion Monitoring (SIM) of 250  

 Line 2 - Full Scan from 100 to 300  

 

SIM 

Full 
 

MS/MS Operations  

 Line 1 - Selected Reaction Monitoring (SRM) 

 Line 2 - Precursor Scan 

 Line 3 - Neutral Loss Scan 

 Line 4 - Product Ion Scan 
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SRM 

Precursor 

Neutral Loss 

Product Ion 

 

MS Operations 
Full Scan Acquisition - Scan for all ions over a defined mass range. Enter the 
start and end masses. 

Example:  

 Line 1 - EI Full Scan, from mass 130 to 280 

 

 

Single Ion Monitoring (SIM) - Detect one or several ions. This mode is more 
sensitive than Full Scan.  

Example: 

 Line 1 - Negative SIM 321 

 Line 2 - Negative SIM 414 

 

 

Mixed Scan Operations - Acquire data in Full Scan and SIM mode at the same 
time. 

Example:  

 Line 1-  Positive SIM 120 

 Line 2 - Positive SIM 230 

 Line 3 - Positive Full Scan from 200 to 400  
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Mixed Polarity Operations - Acquire data in positive and negative ion modes for 
ESI and APCI.  

Example:  

 Line 1 - Positive SIM 120 

 Line 2 - Positive Scan from 200 to 400 

 Line 3 - Negative SIM 230 

 Line 4 - Negative SIM 290 

 

Multiple Time Windows - Several time windows (Segments) can be created for 
an acquisition. You can do full scan, SIM, or mixed operations in each time 
segment and select either positive or negative polarity. 

 

MS/MS Operations 
Product Ion can - Scan for fragments of a particular ion. The precursor ion is 
selected in Q1. In Q3 the start and end masses set the scan range for the 
product ions.  

Example: Precursor ion 219, Product scan 50 -250, and Collision energy 5. 

 

Precursor Ion Scan - The precursor ions of a selected product ion are scanned. 
A start and end mass is set in Q1 and Q3 is set to the desired product ion. 

Example: Precursor scan 100-500, Product ion 195, and Collision energy 10. 
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Neutral Loss Scan - Precursor ions are scanned in Q1. Q3 scans the same 
range minus the neutral loss mass. 

Example:  For loss of m/z 18 (water); precursor scan 100-300, product scan 82-
282. Scan displays product ions resulting from the precursor ions loosing a 
neutral mass of 18. 

 

Selected Reaction Monitoring (SRM) - This process monitors one or more 
MS/MS transition(s) of a precursor ion fragmenting with a specific energy into a 
product ion. The example shows a single transition although more can be 
monitored. 

Example: Precursor ion 414, Product ion 219, and Collision energy -10. 

 

Multiple Reaction Monitoring (MRM) - Multiple reaction monitoring is set up like 
selected reaction monitoring but allows MS/MS transitions between Q1 and Q3 to 
be monitored. Set the Requested Dwell Time to allow for full monitoring. 

Example:  

Line 1 - Positive SIM: Precursor 452, Product 225 

Line 2 - Positive SIM: Precursor 525, Product 315 

Line 3 - Positive SIM: Precursor 633, Product 380 

 

Mixed Polarity MS/MS Operations - Acquisition of MRM in positive and 
negative ion mode.  

Example:  

Line 1 - Positive SIM: Precursor 480, Product 225 

Line 2 - Negative SIM: Precursor 612, Product 375 

Line 3 - Positive SIM: Precursor 452, Product 225 

Line 4 - Negative SIM: Precursor 688, Product 315 
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Multiple Time Windows - Several time windows can be set within one 
acquisition. Each time window can allows Full Scan, SIM, MS/MS, or mixed 
operations and the Request Dwell time can be set appropriately. 

 

 
 



 

Injecting Samples 

There are four steps in data acquisition: 

1. Create or modify an existing method. 

2. Set up a SampleList or enter sample information for a single sample. 

3. Prepare and load the samples onto the AutoSampler. 

4. Start the run. 

Overview 
To make a single injection, use Inject Single Sample.  

To program multiple injections, use SampleList. 

If System Control is not displayed, click this icon  on the large button 
Workstation Toolbar.  

Startup / Shutdown of LC/MS and Analyzer 
The startup and shutdown procedures and the injection methods are the same 
for both the Electrospray Ionization (ESI) and Atmospheric Pressure Chemical 
Ionization (APCI) methods.  

Startup 
The instrument must be pumped down and running before you begin. 

Click Turn Spray On  in the Quad View to turn on the gasses and heaters. 
After the Drying gas temperature reaches at least 75% of the set value, start the 
LC pumps. Wait a few minutes for the temperature to stabilize and click Analyzer 
On/Off to turn on the Detector. 

 Turn Analyzer On/Off 

Spray On/Off 
Collect Data 

 

69  



 

Shutdown 
Turn off the LC pumps. Allow the LC pump pressure to drop down and stabilize 
so the flow into the MS stops. Click the Spray icon to turn off the gasses and 
heaters. The Analyzer turns off automatically when you turn off the source. 

320-MS LC/MS Syringe Pump and Valve 
You can use the six-port valve to divert flow away from the 320-MS, or to make 
injections. You can also set the flow of the syringe pump and have the pump shut 
off at the end of the method. 

Refer to the 300 Series LC/MS and GC/MS Quadrupole Hardware Operation 
Manual to set up the syringe pump. 

1. Click Advanced Options and select the Valve and Syringe Pump tab. 

2. Select Manual, Diverter, or Diverter for the valve. 

3. The system can turn the syringe pump off at the end of the run. 

4. Enable the syringe pump, set the flow, and turn it off when the method is 
done. 
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LC/MS Manual Injections  

Manual Injection 
Plumb the switching valve as shown. 

 

1. Monitor the baseline using the Plot Tic tool in the Tools menu. 

2. After the baseline stabilizes, click the Traffic light and the Collect data file 
window opens. 
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3. Click File naming methods and the Automatic File Naming window opens. 

4. Click Auto-increment. Enter the name of the data file. 

5. Enter 1 for Sequence #, and 2 for digits.  

Note: Click Browse to review or select an existing file name that you may wish to 
use as a root for the file name of your sample. 

 

6. Click OK and the Automatic File Naming window closes.  

 

7. Complete the Collect data window. 

8. Click Apply and if you are ready to collect data, click Start MS. 

9. Check that the valve is in the load position.  

10. Overfill the 5 µL switching valve loop with 3 or 4 times the volume. Push the 
button on the valve cover. Allow at least 1 minute between injections or click 
the valve icon in the Quad view. 

11. Stop data collection by opening the Collect data window and clicking Stop 
MS.  
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GC/MS or LC/MS Injecting Single Samples  
To do one injection, either select Inject Single Sample from the Inject menu or 
click the Inject Singe Sample icon on the System Control menu bar.  

 

Inject Single Sample 
 

If you select Inject Single Sample from the Inject menu, the following window 
opens. The fields are dependent on the sampling device. 

 

Enter the Data File Name and Path 
Data File names can up to 255 characters. You can make them a combination of 
Sample ID, injection date, module name, and injection number.  

Click Data Files, to open the Data Files Generation window. 
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Select the drive letter and subdirectory (path) to store your files from the left side. 
The default directory is the data subdirectory of your VarianWS directory.  

Create a filename format on the right side. You can combine a text entry with the 
“%” symbols to specify filenames with variable sample injection information. An 
example of the filename updates as you enter filename specification.  
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Select a RecalcList 
The files created by SampleList can be stored in a RecalcList, which tracks the 
names of the created files and other parameters. You can reprocess the 
RecalcList later, for example, to reprint the reports or to process data with 
another method). 

Click RelcalcList to open the RelcalcList Generation window. You can create a 
new RecalcList, append to an existing RecalcList, overwrite the RecalcList, or not 
create or update a RecalcList.  

 

If you select Overwrite the RecalcList each time the SampleList Begins the 
RecalcList is overwritten. 

If you select Append to an existing RelcalcList, the new RecalcList has a 
number appended to the filename  

QuickStart 
QuickStart injects a single sample without using System Control directly. 

You can customize QuickStart and set up instruments for routine use. Refer to 
online help for further details. 

QuickStart starts System Control and waits for all modules to log in before 
opening. 

 

Enter information in the MS QuickStart window about your injection. 
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AutoSampler Display  
Each of the supported AutoSamplers has a graphic representation of the 
carrousel or tray. In System Control, click the AutoSampler icon in the Instrument 
Status Window to open it. Inject from a vial by double-clicking on the appropriate 
vial in the display. 

After the Inject Single Sample dialog opens, enter the information, and make the 
injection. 

Click vial 
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Running Priority Samples Using Inject Single Sample  
Use either the graphical vial selection or Inject Single Sample to make a priority 
injection during automated analyses. 

1. While automation is running, click Suspend on the current active SampleList. 
Automation is suspended after the current run is completed. 

2. Double-click on the vial position of the priority sample or choose inject 
single sample and run your sample.  

3. After completing the priority run, click Resume to re-start the SampleList. 

LC/MS or GC/MS Injecting Multiple Samples  
Create SampleLists for different auto-samplers, and using more than one method 
for your injections. 

SampleLists in System Control 
To inject multiple samples from System Control use a SampleList either from the 
File menu or from System Control.  

To create a new SampleList: On the File menu, click New SampleList or click 
Open SampleList to select an existing one. 

 

 
From the System Control toolbar, you can create a new SampleList or open an 
existing one  

 

New SampleList Open SampleList
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Generic SampleList 
If no sampling device is configured, a generic SampleList opens. This  
SampleList does not have fields for vial positions, sampling options or hardware 
configuration options. 

The SampleList fields are like spreadsheet columns and can be sized by 
dragging the border. Right-click a column header to display formatting options. 

Enter Comments Select Post Run Events 

 

The Sample Name field remains fixed as you scroll to the right to help you enter 
information about your samples. 

You can enter data handling parameters, such as, the amount for single internal 
standard calculations, the unidentified peak factor, a multiplier, and a divisor. 

If your requirements are more complex (such as multiple internal standards or 
multiple detectors, which require different entries) use the MultiChannel 
MultiStandard field. 

Each AutoSampler has a unique SampleList. A SampleList can have more than 
one AutoSampler section so it can be used with different AutoSamplers.  

LC/MS - ProStar 410 SampleList 
In addition to the Generic SampleList features, the ProStar 410 supports other 
features such as different Injection Modes, Vial specification, and AutoMix 
functions. 

 Dilute, mix, and/or transfer 
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Click Add Lines to add several lines to the SampleList.  

 

Sequentially number Sample Names  
 

Press Begin, and you are prompted to select a Method.  Use the active Method 
that was pre-selected, or click Browse to use another.  

Click OK, to begin the run. 

 

 

LC/MS - ProStar 420 and 430 SampleList 
The ProStar 420 and ProStar 430 SampleLists have generic System Control 
SampleList fields and fields for operations specific for each AutoSampler.  

Select Partial Loop fill, Full Loop, or µL Pickup from the Injection Mode field. 
Select the User Program from this field also. Several fields are disabled when 
User Program is selected. 
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For the ProStar 430, use the Plate column to specify the plate with the well/vial 
with the sample. Enter a plate number between 1 and 7. This field is disabled 
unless the ProStar 430 is equipped with the Plate Feeder option. 

The ProStar 430 Well/Vial field specifies the sample location as a combination of 
row letter and column number. The available rows and column numbers depend 
on the type of plate configured. 

 48 standard vials: A1 through F8 

 96 well plate: A1 through H12 

 384 well plate: A1 through P24 

Use the Well/Vial field to randomly access any well or vial. For example, you can 
periodically recalibrate from a single standard in a fixed location. 

For the ProStar 420, the Vial field specifies the sample vial as a combination of 
Tray type letter and Vial number. The available Tray types and Vial numbers 
depend on the Tray Segments configured. You can randomly access any vial. 

In the Wash Volume field enter a wash volume in the range of 300 to 9999 L, 
or enter 0 for no wash. 

In the Automix Routines field, define a specific automixing program to be done 
before the sample is injected. When doing an Automix routine, you can program 
the AutoSampler to aspirate liquid from a well, vial, or a reagent vial, and transfer 
it to the sample well or vial from which an injection is to be made.  

You can mix the sample by aspirating and dispensing specified amounts. 

You can program the AutoSampler to wait for specific time interval. Use the 
Automix Steps dialog to select Action, Position, Amount, Speed of the syringe, 
and Height of the needle. The following is an example of an automix routine. 
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A maximum of 240 steps can be programmed in one automix routine. After 
entering all the steps, enter a name for this Automix Program in the box next to 
Cancel and press OK. The program is saved in the SampleList, and can be 
exported to other SampleLists. Alternatively, Automix Programs from other 
SampleLists can be imported to the active SampleList using Import. 

The User Program column is enabled if selected in the Injection Mode field for 
the sample. The User Program can do sample handling and injection actions. 

When the User Program is selected as the Injection Mode, the following fields 
are disabled; Injection Volume, Wash Volume and Automix Routines. The User 
Program steps are used instead of the method parameters. You must use the 
User Program if the 10-ml syringe is selected. The following figure shows lists the 
User Program Actions. For each specified action, there could be several options 
such as Position, Amounts, Speed Setting, and Height.  
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You can start the run, either on the INJECT Marker (step 9 in the above 
example), or at the End of User Program. Up to 240 steps can be programmed in 
one User Program. After adding all steps, enter a name for this User Program in 
the box next to Cancel (UserProg_1 in the above example), and press OK. The 
User Program is saved in the SampleList, and can be exported to other 
SampleLists. Or, use Import to bring User Programs from other SampleLists into 
the active SampleList. 
 

To build a ProStar 420 SampleList or a ProStar 430 SampleList, click Add. 

 

You can enter information that is common for all samples. You can select the 
number of entries to be added sequentially to the SampleList. With the ProStar 
420, you can specify the first and last vials to be added to the SampleList with 
the requirement that the first and last vial numbers start with the same Tray Type 
letter, either A, B, C, or D.  

With the ProStar 430, you can specify the first and last Row and Column to be 
added. You can also select to add by Rows or Columns, which determines if the 
plate is processed from left to right by row or from top to bottom by columns. 

GC/MS - CP-8400/8410 SampleList 
In addition to the Generic SampleList features, the CP-8400/8410 has settings 
for Vial position, Injection Volume and Injector Selection. If SPME hardware is 
installed, the Injection Volume field is disabled and the fiber Adsorption Time set 
in the GC control section of the Method is used for sample extraction. 

 

 

Select Manual from the Injectors Used field to disable the CP-8400/8410 and 
make a manual injection. In the following example, the CP-8400/8410 injects 
samples 1 and 2, then waits for a manual injection/start from the GC for sample 
3, and continues with samples 4 and 5 using the CP-8400/8410. 
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The CP-8400/8410 can also make two injections in the same GC method run. 
Select second injector from the Injectors Used field. 

 

If two injectors are used, you can, for the second injector, inject the same sample 
as the first injection (Duplicate) or inject the sample from the next vial position 
(Advance). You can wash the syringe in between injections (Clean & Dup, or 
Clean & Adv). 

In the following example 1.0 µL of Sample 1 from vial 5 is injected by injector 1, 
there is a 2.0 seconds delay, and 2.0 µL of Sample 2 from vial 6 is injected by 
injector 2. A separate data file is created for each sample. 

 

 

Combi PAL SampleList 
In addition to the Generic SampleList features, the Combi PAL for GC/MS and 
HTS PAL for LC/MS have settings for Tray selection, Vial position, and Injection 
Volume. If the Combi PAL is configured for SPME sampling, then the Injection 
Volume field is disabled and the fiber Extraction Time set in the Combi PAL 
control section of the Method is used for sample extraction. 

All other sampling parameters are specified in the Combi PAL section of the 
Method. 
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Default SampleList Entries 
When you add a new row to a SampleList, default values are entered. To change 
them, click Defaults and the Set ProStar 420 SampleList Defaults dialog box 
opens. Enter the desired default values and click Save. 

 

 

Note that neither volume nor rack and vial number is displayed, even if an 
AutoSampler is present. 

Saving SampleLists for Later Use 
When you make changes to the open SampleList, the changes are automatically 
saved to the SampleList file and are used for the automated runs in progress. If 
you want to edit a SampleList other than the open SampleList, use the offline 
Automation File Editor application described in the next section of this manual. 

Using More Than One Method for Injections 
You can do automated injections using more than one Method. There are two 
ways to do this: change the active Method in the SampleList or use a 
SequenceList. 

Changing the Method in the SampleList 

Change the Method by activating a Method in a SampleList row. 
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Select Activate Method  Click AutoLink 

 
 

 

Select Method. 

Enter Method Name 

 

Using the SequenceList Window 
On the File menu, select a New SequenceList or Open SequenceList.  

 

 
 

You can also create a new SequenceList or open one from the System Control 
toolbar. 

85  



 

Create a new Automation File 

Open an existing Automation File 
 

In the SequenceList, select an Action. Enter the Method and the SampleList or 
click Browse to select from a list. 

Browse for a Method or SampleList. 

Enter the Method and SampleList. 

Select Action. 
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Monitor Run Status  
After making an injection, monitor the run in System Control. 

 

 

The status and control window and the Toolbar display the module status. 

Message Log 
Automation actions and errors are logged in the Message Log. The most recent 
entry is at the bottom. Double-click the status bar at the bottom of the instrument 
window to display the entire Message Log. The log is saved in the 
c:\VarianWS\MSGLOG directory. 

 

Message Log entries are stamped with the time and date. 

Automated MS Report Generation 
By adding Report sections to your Method, you can generate automated reports 
from System Control after each injection, after Recalculations, or by using Print 
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actions in the Sequence window. When Automated Printing is enabled, a 
checkmark appears in the front of the Enable Automated Printing menu listing. 
To disable automated Report printing during an automated sequence of 
injections or Recalculations, click Enable Automated Printing from the 
Automation menu to disable it and remove the check mark. SCII file generation 
is still performed, if selected in the Report Method section. When you disable 
automated printing, automation continues but no reports are printed.  
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Stopping an Acquisition 
During automation and while the LC/MS or the GC/MS system is running you can 
suspend or stop data acquisition from the Automation menu in System Control as 
follows: 

Suspend Automation - Suspend automation after the current run is completed. 

Stop Automation - Stop the current run, resets all modules and suspends 
automation. 

Resume Automation - Resume automation after suspension.  

Reset Modules - Stop the current run, and reset all modules. Automation 
proceeds to the next injection after all the modules go to the Ready state. 

   

 

If the Acquisition was started from the Start collecting data dialog  in the 
window Toolbar, click Stop MS to end data acquisition or in the Automation 
Menu bar click stop Automation. 
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Set a Collect Delay 

LC/MS  
The 320-MS 6 port valve can be used to divert the LC effluent away from the API 
Source. Frequently, the solvent front contains un-retained non-volatile salts from 
the sample. If not diverted, these salts would deposit on the source and the 
source may require more frequent cleaning. The delay parameter switches the 
diverter valve to waste for a set time interval.  

While the flow is diverted from the source, you can delay data collection in the 
Acquisition Method. The syringe pump can be connected and programmed to 
provide flow to the API while the LC effluent is diverted. 

GC/MS  
Use the Delay parameter to turn the filaments on after a time interval. This is 
used in GC/MS runs to prevent the filaments from being damaged or broken 
when the solvent peak elutes. 

Acquisition Method 
In Method Builder, open the Acquisition Method. Enable Use delay and enter 
the delay time in minutes. 
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MS/MS Breakdown  
The Breakdown Curve feature makes MS/MS method development easy. The 
sample is introduced into the mass spectrometer API source with a syringe 
pump. A precursor ion is selected for MS/MS breakdown curves.  

The precursor ion can be viewed in the profile or centroid mode by entering 
SW xxx in the Ctrl text field (see below).  

 

 
 

 

 

 

 

 

 

 

91  



 

On the Tools menu, click MS/MS Breakdown. 

 

In GC/MS mode, your only choice is Q2 collision cell. 

In LC/MS mode, you can select Q2 Collision Cell Breakdown, or API Capillary 
Breakdown. 

Click Q2 Collision cell.  

 

The Create a breakdown curve window. 
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1. Enter the precursor ion in Parent mass.  

2. Click Turn on CID gas. Wait about a minute for it to stabilize. 

3. Select either Normal (0.5 V steps) or Fast (2V step) Collection speed. Either 
is adequate for most conditions.  

4. To save the product ions to a method, select Enable, select Save, choose 
the number of products to save. 

5. Click Browse to select the method in which to save the product ions with the 
highest intensities. 

6. Select Apply, and then Start. 

The breakdown curves are displayed. 

To add additional ions to the method, repeat the process for the next precursor 
ion. For example, type SW 790 in the Ctrl line (or SW and whatever precursor ion 
you choose). 

For this additional precursor ion, select Auto find product masses or specify 
the product masses. 

To add ions and collision voltages to an existing method, select Append and the 
appropriate method. 
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If you select API capillary, do the following after the Create a breakdown curve 
by scanning the API capillary window opens. 

 

 

 

1. Enter a range to auto find product masses or enter up to five masses. 

2. Select either Normal (0.5 V steps) or Fast (2V step) Collection speed. Either 
is adequate for most conditions.  

3. To save the product ions to a method, select Enable, select Save, choose 
the number of products to save. 

4. Click Browse to select the method in which to save the product ions with the 
highest intensities. 

5. Select Apply, and then Start. 

The breakdown curves are displayed. 

To add additional ions to the method, repeat the process for the next precursor 
ion. For example, type SW 790 in the Ctrl line (or SW and whatever precursor ion 
you choose). 

For this additional precursor ion, select Auto find product masses or specify 
the product masses. 

To add ions and collision voltages to an existing method, select Append and the 
appropriate method. 

 

94  



 

Analog Channels 
Two analog channels can be configured in the 300 Series by Analog Out 
selections or by defining PML outputs. 

Select Analog output of from the Tools Menu 

 

 
The Analog Out widow opens. 
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To create an Analog signal output:  

1. Connect the wires to the pins on the User I/O connector on the back of the 
instrument. For example, in the preceding screen Analog output #1, the 
signal wire, connects to pin 14 and the ground connects to pin 32. 

2.  Also check In Use for the appropriate channel in the Analog Out dialog. The 
part number of the user IO Board is CUB06-0047. 

 
User I/O pins 

 

 

 

 



 

Automation File Editor 

Overview 
Use the Automation File Editor to create and edit SampleLists, RecalcLists, and 
SequenceLists outside of the Varian MS Workstation System Control application. 
Access the off-line Automation File Editor without disrupting automated runs. 

NOTE: SampleLists and Sequences that are active and running in System 
Control cannot be accessed in the off-line Automation File Editor. 

Accessing the Automation File Editor 

Click the Automation File Editor icon  on the Workstation Toolbar. 

Create or Edit a RecalcList 
Either select a New RecalcList or Open an existing RecalcList from the File 
menu. 

 

 

The RecalcList window opens. The table is like a SampleList. RecalcList may 
contain AutoSampler and sample specific data handling information. The 
RecalcList contains the Data File name and data file specific data handling 
information. Fields, common to both the RecalcList and the SampleList, are 
described in the SampleList section. 
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Recalc Notes - Enter notes about the Recalculation of the Data File. 

AutoLink - Enter post calculation operations. 

Report - Generate a report for the selected data file. Note that if a data file is not 
highlighted in the Data File column, no report is generated. 

Actions - After generating a report using the Report button, click Actions to show 
possible actions. 

 

 

Create or Edit a SampleList 
Either select a New SampleList or Open an existing SampleList from the File 
menu. 

 

 
Select a folder for the SampleList, enter a name, and click Save. 
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Select the autosampler and click OK. 

 

Size the Spreadsheet columns by dragging their borders with the left mouse 
button. Right-clicking a column header displays formatting options. The Sample 
Name column does not scroll.  

 

99  



 

SampleList Fields  
Sample Name - Enter the sample name. Create sample names by clicking Data 
Files. If only ‘%s’ is listed in the Data Files the sample name is as you entered it. 

Sample Type - Use the scroll bar to see all options. 

   

Cal. Level - Designate the calibration level for a Calibration sample. You can 
enter up to ten levels. 

Inj. - Specify the number of injections of the sample. You may make up to nine 
replicate injections of each sample. 

Injection Notes - Enter notes about the sample. 

 

AutoLink - Refer to the ‘Specifying Data Handling Parameters’ section in this 
manual. 

   
In the Vial, Injection Volume, and Injectors Used fields, enter the appropriate 
information.  
The field beginning with Amt. Std. is only for data files acquired with standard GC 
detectors.  

 

Select the Method for the run. Click Browse to select a file. 

Other Fields 
Add - Adds a new line to the end of the list. 

Insert - Inserts a new line before the currently active line. 

Delete - Deletes the currently active line. 
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Fill Down - When sections of columns or entire lines are highlighted, the 
information in the top highlighted row is repeated to the lowest selected row. 

Add Lines - Add several similar lines to the SampleList. Enter the common 
information in the dialog box. Fields in Add Lines may vary from one 
AutoSampler to another. Only the fields associated with the selected 
AutoSampler are displayed.  

 

For sequentially numbered Sample names, check the box and enter the starting 
number and the number of entries to add to the SampleList. The Sample Names 
will have these numbers appended to them. 

Defaults - Change the default entries in the table, such as Injection Volume, 
Injectors Used, etc. After defining new defaults, click Save to activate the new 
defaults. 

Data Files - Change the location and name of the Data Files. 

RecalcList - Click and generate automatically a RecalcList associated with 
single sample acquisitions. 

Specifying the Data File Name and Path 
Data File names can be up to 256 characters long. Sample ID, injection date, 
module name, and injection number can be embedded in the file name making 
the Data File name correlate with each sample injection.  

Click Data File to open the Data Files Generation window. Select the path and 
the file name for the data file.  

 

Select the data file directory from the left side. Create a file name specification on 
the right. You can combine text entry with the “%” variable symbols to specify file 
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names that contain sample injection specific information. An example of the file 
name is updated as you enter the file name specification.  

Specifying a RecalcList 
To select the desired RecalcList option, click RecalcList. The RecalcList 
Generation window opens. You can create a new RecalcList, append to an 
existing RecalcList, or not create nor update a RecalcList. When you select 
create and update a new RecalcList, the automatically generated RecalcList 
does not overwrite an existing RecalcList. If a RecalcList with the same file name 
exists, the newly created RecalcList has a number appended to its file name to 
make it unique and to prevent the older RecalcList from being overwritten. 

 

Changing Default SampleList Entries 
When you add a new row to a SampleList, default values are used for each 
entry.  

To change the default values: 

1. Click Default in the open SampleList window. 

2. Enter the desired default values and click Save. 

 

Using More Than One Method for Injections 
You can do automated injections using more than one Method by changing the 
active Method from the SampleList or using a Sequence. 

Changing the Method in the SampleList 

Change the Method used during injections by activating a Method in a 
SampleList row. 
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Select Activate Method from the Sample Type cell. 

Click AutoLink in the row that you are working. The Activate Method widow 
opens. 

 

Enter the name of the Method or click Browse to select the Method from a list. 

 

Specify any number of Methods in the SampleList. 
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Create or Edit a Sequence 
From the File men select New and then Sequence or select Open and then 
Sequence from the File menu. 

 

The Sequence window opens. 

 

1. Click Add to add lines to the SequenceList. 

2.  Enter the required number of Sequence lines. 

3. Select the Action for the selected step. 

4. Click Browse to select the Method and SampleList files. 
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Compound Table 
In the Method Builder tree, click Compound Table under MS Data Handling. 

 

The Compound table has the following fields; Retention time (Ret), Internal 
Standard (IS), Compound ID, Quanitation Ion (Quan Ion), Calculations, 
Integration, Identification, and Reference Spectrum (Ref Spectrum).  

 Click Select Data File to open a different data file. 

 Click to Sort, Add, Insert, Delete, Fill Down, or Restore compounds. 

 Other functions are: Build Compound List, Import Compound List, 
Export Compound List, and Print. 

 Before processing calibration files, review the compound table to check 
that the entries are correct. 

 Double-click a cell to open the Compound Tab view. In this example, Ret 
7.316 was selected. 

Click Show/Hide Directory  to display the method full screen. 

Creating a Compound Table 
1. Click Build Compound List. 

2. Click each peak to create an entry. 

3. In the Method Editor, click Import Compound List, and click Select to put 
your compound list into the method. 

Note: You can double-click a cell to display more information. 
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Compound Attributes 
The following shows the Compound Attributes tab view after the retention time 
7.613 was double-clicked. The Chromatogram and Spectrum Displays are on top 
and the bottom part has fields. After you select Quan Ions, other than the RIC, 
(for example, in the Build Compound Table dialog in MS Data Review or in the 
Quan Ions Tab view) use the selected Quan Ions for Plot parameters. 

Add information, such as Compound Name and CAS Number, during the peak 
addition process. 
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Edit Name, CAS Number, Retention Time 

You can edit the Compound Name and CAS fields. 

Click the chromatogram display to update the Retention Time. The spectrum of 
the selected scan is displayed. It becomes the new reference spectrum if you 
select it when you exit the tab dialog, or click Next or Previous to move to a 
different entry. 

Identify Internal Standards 

By default, compounds are identified as Analytes. Identify all Internal Standards 
by checking them, as in preceding screen shot. Click Next, or Previous to check 
the Compound ID information of the other analytes. If more than one internal 
standard is identified, select the internal standard for a particular target 
compound from the IS to Use list. 

Identify Group Members 

Sometimes target compounds are identified as a member of a group of 
compounds (for example, Trihalomethanes (THM), alkyl aromatics, etc.).  

Enter the desired name in the Group Names field. 

If more than one Group is designated in a method, select the Group Name from 
the list. 
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Quan Ions 
Click the Quan Ions tab in the Compound Table editor. When peaks are added 
to the Compound Table, the software names the Base Peak (most intense ion) 
the Quantitation Ion. The plot shows the mass chromatogram for the chosen 
Quan Ion.  

 

Edit Quan Ions 

Select a different Quan ion, a sum of ions, or a range of ions. 

 

If you selected Ion(s), Select Ions to Plot opens. Select Show Format and 
Examples to display the ways to specify ions. The Plot is redrawn automatically 
after you select the Quan Ions. You can determine if the chosen Quan ions 
integrate cleanly or if there are interferences due to co-eluting peaks or 
background contamination. 

NOTE: The Scan Function Channels field is only relevant for MS/MS or SIM 
analysis, because quantitation may be done on individual Channels of 
information.  
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Edit Retention Time 

To change the retention time, click the desired scan in the Chromatogram 
display. 

Look at Other Compounds 

Click Next, or Previous to see the Quan Ion information for other peaks in the 
Compound Table. 

Select Qualifier Ions 

In addition to specifying quantitation ions, you can select qualifier ions. Click 
Load to enter automatically the three most intense qualifier ion candidates 
present in the Reference Spectrum. 

 

Click Add to add the next most intense reference spectrum ion. 

The Qualifiers Table has the following fields: 

Ion - Click in the Ion field to see the choices.  

Ratio - Shows the intensity of the qualifier ion as a percentage of the chosen 
Quan ion(s).  

%Uncert. - Allowed percentage deviation from the Ratio. You can change the 
default of 20%. The % Uncertainty allowable range dependents on the Ion Ratio 
Type setting in the Calculations Setup Dialog (Absolute % or Relative %).  

Low% and High% - For ion 63, the top line in the previous example, and the 
allowed range for the ratio is 87.5.0  20% (absolute). Therefore 67.5% is the 
Low% value and 107.5% is the High% value area.  
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As samples are processed as Calibration, Analysis, or Verification runs, the 
Qualifier Ion tests are done before the peak is integrated. 

Calculations Tab  
Click the Calculations tab to display the following. 

 

Enter Number of Calibration Levels and Amounts 

Enter the number of calibration levels, information about the calibration curve, the 
calibration amounts, and results units.  

 

The Calculations Information is updated in the Compound Editor dialog. This 
information can be automatically entered for the other compounds in the table.  

 

Click Copy Amounts to enter automatically enter the first value for the other 
levels. Repeat this process for all standards in the Compound Table. 
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Select Curve Fit  

Select the desired curve fit from the list. 

 

For most calibration curves, use either Linear or Quadratic.  

NOTE: For more information about the Integration, Identification, and Reference 
Spectrum Tabs, and other information about Quantitation and Data Handling: see 
the MS Software Reference Manual (part number 391496300). 
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Security Administration 

Overview 
 

The Security Administration window contains three categories of security 
parameters. These features are tools for compiling with 21CFR part 11. 

 Passwords 

 Application Locking 

 File Revision Settings 

Click the Security button on the Workstation Toolbar to open the Security 
Administration window. 

 

Passwords 
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Area Description 

Password for this application Specify a password required to open the Security 
Administration application.  

NOTE: There is no way to recover this password if it is 
lost, so document the password in a secure location. 

Change Method Passwords Method passwords can be added, changed, and 
removed from the Security Administration application. 
Click Select Method to browse for and select the desired 
Method. After the Method is selected, you are prompted 
either for a new password (if no previous password 
exists for the Method), or for the old and new password 
(if the Method already contains a password).  

NOTE: that if creation of new passwords is disabled in 
the File Revision tab, you cannot add a new password 
to a Method that does not already contain one. 

Change or add Method passwords in the Method Builder 
and Interactive Graphics applications. 

Remove Method Passwords Security Administrators can remove Method passwords 
without entering the existing password. This is useful if 
the password for a Method was lost. Click Select 
Method, select the desired Method, and the password is 
removed. 

 

Application Locking 
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Area Description 

Unlocked Applications Lists the top-level windows currently running and not locked. 
Select any number of them and click Lock. 

They move to the Locked Applications list and their windows 
are disabled (they will not respond to mouse or keyboard 
input). 

Note applications locked by the Security Administration stay 
locked after the Security Administration application closes. 

Locked Applications Lists the top-level windows currently running and locked. 
Select any number of them and click Unlock. They move to 
the Unlocked Applications list and their windows are enabled 
(they respond to mouse or keyboard input). 

 

File Revision Settings 
 

 

Area Description 

Require Revision Log entry 
when changes to Methods 
are saved. 

When checked, prompts you for a description of 
changes when a Method file is altered and saved.  

The Revision Log appears: 

 Listed in the Notes of the File Open dialog box. 

 Listed in the Method Builder application window 
when the Method is open. 

 Included in the Method printout. 

Update Revision Log in Data 
Files with Recalculation date, 
time, and Method name. 

Data Files are updated with a time stamp and Method 
name when they are recalculated (either from System 
Control or from Interactive Graphics).  

The Log can be included in printed reports. 

Enable results deletion from 
"Open Data File" dialog 
boxes. 

A button appears in the Open Data File dialog allowing 
results to be deleted from a specified channel of a Data 
File.  

Results deletions are logged in the Data File's Revision 
Log.  

This option only affects standard GC results. GC/MS 
results will not be deleted. 

Disable creation of new 
passwords in Method files. 

When checked, new passwords cannot be added to 
Methods.  

Methods with passwords prompt users for their 
password before saving changes. 
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Configuring HPLC Modules 

Overview 
The Varian MS Workstation supports the Varian HPLC modules and the HTS 
PAL autosampler. 

Refer to Data Acquisition with LC Control, part number 391473200 and 212-LC 
Operation Manual, part number, 395410300 for details.
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Configuring GC Modules 

Overview 
Since the 3800 GC communicates with the Workstation over a standard Ethernet 
connection, your system can easily be expanded from a single 3800 GC/single 
Workstation configuration, to multiple 3800 GC/Workstations, to a fully networked 
lab with a virtually unlimited number of GCs and Workstations. The term 
“Ethernet” refers to the cables and interface cards that connect devices to the 
network. If you are connecting your 3800 GC to an existing Ethernet network, 
you need to know which type of cable to use. Refer to the Communications 
section of the 3800 GC Operator’s Manual. 

The 3800 GC uses TCP/IP (Transmission Control Protocol / Internet Protocol) to 
communicate over the Ethernet network. Since the 3800 GC uses TCP/IP to 
communicate with the Varian MS Workstation, the Workstation PC and the 3800 
GC need unique IP addresses—the addresses that are used to identify each 
networked TCP/IP device. 

Refer to Data Acquisition with 3800 GC Control, part number 391473100, for 
detailed information about how to acquire data, build methods, and operate the 
3800 GC with your Varian MS Workstation. This manual also describes the 
configuration of the 3800 GCs for standard Ethernet communication with System 
Control. 
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PML 

Overview of PML 
The procedures that generate information reporting results from the mass 
spectrometer are written in a language called Paw Macro Language (PML). It has 
single commands that control the instrument or data processing. Users can write 
procedures to customize data processing. 
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Simple Commands 
Simple commands can be entered in the CTRL field. 

 

Typing “Hello” (quotes included) in the CTRL text box prints Hello in the out 
status display on the task bar.  

CANCEL stops the Paw macro running at the top level. 

QUIT stops all paw macros. If you use the ‘Quit’ key word, type ‘scan’ to restart 
the system. 
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PML Syntax 
The macros are text files with the extension .pml. There are macros in the PML 
Directory (default: C:\VarianWS\1200sys\PML). If you create your own macros or 
make new versions of the existing ones, store them in the User PML Directory 
(default: C:\VarianWS\UserPML). Macros can be edited using the Pml Editor 
described later in this section.  

The names can contain letters, numbers, or underlines, but they must begin with 
a letter. 

Run a macro by typing the name of the command lines of the instrument window 
(CTRL) or including the name in another macro. You can send arguments to a 
macro and it will return a value. 
 

Paw Macros Consist of 
Statements: 

Examples: 

Action or function keywords: OFF 
DOZE(2.5) 

Macro calls: CGON 
SW(219) 

Assignment statements:  DETECTOR = 1000 
DETECTOR += 50 
DETECTOR -= 50 
x = COS(PI) 

Conditional Statements:  IF (WIDTH > 10) 
ELSE 
WHILE (x < 100 & y <= 100) 
UNTIL (x = 100 | y != 100) 
REPEAT 100 
REPEAT 

Completing Statements: END 
terminates a conditional statement 

 RETURN(n) 
returns from a subroutine with result n 

 CANCEL 
stops the paw macro running "at the top level" 

 QUIT 
stops all paw macros 

Printing statements: ?DETECTOR 
prints the current detector value on the display. 

 "Hello" 
prints Hello on the display. 
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The Statements Refer To: 

numerical values e.g. 20, -3.5, 1000H 

variable keywords e.g. DETECTOR 

function keywords e.g. COS 

action keywords e.g. FISH 

macros e.g. STANDBY 

user variables e.g. X,Y 

arguments e.g. %1,%2,%3,%4,%5 

   

Notes 

1. Statements are separated from each other by colons, semicolons, or line 
breaks. 

2. Conditional statements must have a matching END statement,  
e. g.: 

 if (x < y) & ~(x = 2) : fish : else : scanlens : end 

 if x = 3 : sw(502) : end 

 i = 1 : repeat 100 : sn = i: list(i) = tic : i + = 1 : end 
 

However, END statements at the bottom of a PAW Macro can be deleted. 

3. Printing statements (using ? and "") can be strung together. They are 
terminated with the keyword CR (carriage return). 

4. Some keywords create text like the printing statements using ? and ".” 

GET_FILENAME 

LIB_FORMULA 

LIB_NAME 

LIST_TO_STRING 

SAMPLE_NAME 

STRING_RESTORE 

SUB_FILE_NAME 

VERSION 

5. Some keywords re-route the text created by printing statements (using ? and 
") to other places than the display. 

DACS_RESTORE : "file name” : CR 

DACS_SAVE : "file name” : CR 

FILE_APPEND : "file name” : CR 

FILENAME : "file name” : CR 

FILE_OPEN : "file name” : CR 

IONS_RESTORE : "file name” : CR 

IONS_SAVE : "file name” : CR 
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LCD : "message” : CR 

LIB_FIND : "compound name” : CR 

LIST_RESTORE : "file name” : CR 

LIST_SAVE : "file name” : CR 

MSGBOX : "label text” : CR : "default”: CR: 

 "Macro”: CR 

PICT_LABEL : "label text” : CR 

PICT_TITLE : "title text” : CR 

STRING_SAVE : "text" : CR (ten user strings) 

STRING_TO_LIST : "text" : CR 

SUB_NAME : "text" : CR 
 

6. Statements may include comments. A # ends the statement and starts the 
comment, e.g., :DETECTOR += 10 # raise the detector to make the peak 
bigger. 

7. All numerical values referred to in PAW Macros are real numbers. Usual 
algebraic syntax is allowed:, e.g., x = (sin(y) + cos(sqrt(detector))) / (30 * 
month + day). 

8. When parameters are passed to macros, they are referred to within the 
macro as %1, %2, %3, %4 and %5. e.g., if the macro TIMES is defined as 
?%1 : "times" : ?%2 : "equals" : ?(%1 * %2) : CR and you type "TIMES 7 9" 
and the instrument will print out "7 times 9 equals 63". NOTE: %1 - %5 can 
be used as local variables within any macro. 

9. When passing parameters to a macro or keyword, you can leave out 
parentheses at the top level. 

All these are valid statements: 

FISH(3) 

FISH 3 

FISH 3 2 

FISH 3,2 

FISH(3,2) 

When assigning a value to a variable or parameter you can leave out the 
= sign. 

DETECTOR = 1000 

DETECTOR 1000 

but:  "lens(1) = 100" is ok while "lens 1 100" is ambiguous. 

10. When using printing statements on the control line, or if the string you type 
starts with? or " or VERSION, you don’t have to type the terminating CR. 
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System Paw Macros 
1. When the Status Window is opened, a Ctrl: PML (default: INIT) and a Proc: 

PML (default: QUAN_INIT) are both run. 

2. In the Collect menu (toolbar start button) a Ctrl: PML is defined which runs 
when the file being collected is opened. 

3. In the queue menu (Collect Queue edit button) a Proc: PML is defined which 
runs when the file being collected is closed. 

4. A Windows application outside the instrument can request a PML through the 
windows DDE mechanism. 

5. Using the MSGBOX keyword you create and run PMLs. 

6. Some PMLs run when you click on buttons or menu items: 

File menu Reset:  INIT 

File menu Standby:  STANDBY 

Status control menu:  CGON CGOFF CION CIOFF CIDON CIDOFF 

AutoTune menu:   ATUNE1 ATUNE2 ATUNE3 ATUNE4 ATUNE5 ATUNE6 

Diagnostic menu:  DIAGNOSTIC(test_number) 

Tune Table menu optimize button:  OPTIMIZE 

Status probe button:  PROBE_MAIN 

Species Boiling Pt. Range menu compute button: SHELL 

Clicking in Chro:  CHRO_CLICK(sn,rt,type_rt + (10*type_sn) + 
(1000*make_substance)) 

(click on the CHRO scales button to see where type_rt,type_sn, and 
make_substance are defined) 
 

Other popular PMLs are: 
BL PAR 
DAU QIMS 
FM Q3MS 
LM SCAN 
MIXED SW 
NL 
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Help Files for PML 
Click Help in the System Control window to open the Paw Guide. 
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 Some PML Procedures 
The Cioff.pml macro closes the CI gas valve, prints “Evacuating CI Gas (takes 5 
seconds)” in the status area of the taskbar, opens and closes the vent valve, and 
prints “CI gas off” in the status area of the taskbar. 

CIOFF.pml 

valve 2 = 0 # close CI valve 

"Evacuating CI Gas 
(takes 5 seconds)";cr 

#printing statement, terminated with the keyword CR 
(carriage return) 

doze 1 #wait one second 

valve 4 = 1 # open CI vent valve for 0.2 seconds 

doze .2  

valve 4 = 0 # close vent valve for one second 

doze 1  

valve 4 = 1 # open vent for 3 seconds 

doze 3  

valve 4 = 0 # finally close vent 

"CI Gas off!";cr #printing statement, terminated with the keyword CR 
(carriage return) 

The LEAK.pml assists in finding vacuum system leaks. It sets a series of masses 
from a compound or mixture used for leak detection. First. the Pict view window 
is cleared, the title in the Pict window is set, centroid mode is set, mass range is 
set, the parameters are optimized to prevent saturation, and a series of mass 
intensities are plotted while the user sprays a gas at possible leak locations. 

LEAK.pml 

pict_clear # clear the picture/graph window 

pict_title:"1->mass 18,  
2->mass 28, 3->mass 
33, 4->mass 45, 5-
>tic":cr 

#Sets the title in the pict view 

cent #Go to centroid mode 

fm 10 #Set first mass (FM) to 10 

lm 50 #Set last mass (LM) to 50 

optdet #Optdet runs opt_detector.pml to prevent detector 
saturation after each scan. 

repeat #repeat items below 

fish #go get one scan of data 

pict(,area(18),1) #get area of mass 18 and plot point in pict view position 1 

pict(,area(28),2) #get area of mass 28 and plot point in pict view position 2 

pict(,area(33),3) #get area of mass 33 and plot point in pict view position 3 

pict(,area(45),4) #get area of mass 45 and plot point in pict view position 4 

pict(,tic,5) #get area of mass total ion current (tic) and plot point in pict 
view position 5 

end  
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Mixed.pml gets one scan in centroid data and one scan of profile data. 

MIXED.pml. When Prof and Cent views are selected in the window, both real 
time centroid and Profile data is observed. 
 

Repeat #repeat items below 

Prof #set to scan of profile data 

Fish #go get one scan of data 

Cent #set to scan of centroid data 

Fish #go get one scan of data 

End  
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PML Editor 
The PML Editor is used for creating and editing PMLs for the 300 Series 
software. The PML Editor allows access to the factory PML files; however, if a 
factory PML is modified it will then be saved as a user PML in the UserPML 
directory. 

Accessing the PML Editor 
Click Tools in the Quad module window to display the PML editor.   

 

The PML editor window opens.  

 

 Varian PMLs are stored in c:\varianws\1200sys\PML directory. 

 User created PMLs or modified factory PMLs are stored in 
c:\varianws\UserPML directory. 
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 The Status Bar of the PML Editor displays the line number of the current 
cursor position. 

Selected line number 

 

 The Tool menu has three menu items: 

Version History: If the 21CFR11 application is enabled, click this to display the 
version history of the currently open PML. 

 

 

PML Info: Display the PML path name, release version number, and any 
descriptions that have been in the PML header section. (Lines begin with ##). 
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PML Utility: Use this to perform syntax checking of the currently open PML and 
produce a call tree, PML keywords and User Variables defined in the PMLs. For 
the keywords listed, user can select and use F1 to get online help about the 
keywords. 

In the right part of the utility dialog box, user can enter a specified keyword, and 
find out the PMLs contain this keyword. 
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